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Introduction 
 
Than
instr
 

Wh

k you for purchasing the Korg RK-100S KEYTAR. In order to take full advantage of your new 
ument, please read this manual and use the product as directed. 

at is RK-100S Sound Editor? 
RK-100S Sound Editor is software that takes advantage of your computer’s large screen to let you edit 
and manage the RK-100S’s programs and global data with ease and convenience. 

 

Caution 

 Do not disconnect the RK-100S or power-off the RK-100S while RK-100S Sound Editor is running. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 
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Operating requirements 
A computer that satisfies OS requirements and a USB cable are necessary to use the RK-100S Sound 

Operating system: Mac OS X 10.6 or later. 

Editor. 
Mac 

 

Windows 
Operating system: Windows 7 SP1 (32bit, 64bit), Windows 8.1 (32bit, 64bit). 

 

 Operation with touch panel is not supported when running Windows 8.1. 

 Full functionality is not guaranteed with all computers that satisfy these system requirements. 
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Installation 

lation for Windows users 
 

Instal
Pro n ows. 

. Double-click “Setup_E.exe” to start the installation process. 
-100S Sound Editor installer will start up. Follow the on-screen directions to install the 

ceed as follows to i stall the software in Wind
1
2. The RK

software. 
 

Installation for Mac OS X users 
Proceed as follows to install the software in Mac OS X. 
1. Copy the “RK-100S Editor” folder to the “Applications” folder. 
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Quick start 
 

Settings in RK-100S Sound Editor 

 In order to use RK-100S Sound Editor, you must download the Korg USB-MIDI Driver from the 

puter. 
. Move to the ”RK-100S” folder, and start up “RK-100S Sound Editor.” 

d in the taskbar's "Start" - "All Programs" - "KORG." 
d in the "Applications" folder. 

ata will be received from the RK-100S. 

Korg website and install it as directed by the accompanying documentation. (http://www.korg.com/) 

1. Using a USB cable, connect the RK-100S to your com
2

Windows The "RK-100S" folder is locate
Mac OS X The "RK-100S" folder is locate

3. The library window will open automatically, and all d

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

diting a program 
 

E
Go ahead and try editing a program in RK-100S Sound Editor. In the Library window, click the 

ROGRAM] button to access the program page. From the program list in the Program page, select the 
rogram that you want to edit and click the [EDIT] button to open the Program Edit window. Use the 
nobs and buttons to edit the sound. For details on how to operate the knobs and buttons, refer to “Basic 
perations in the editor windows.”  

riting a program to the RK-100S 

[P
p
k
o
 

W
In order for the parameters that you’ve edited in the RK-100S Sound Editor to be stored into the memory 
f your RK-100S, you’ll need to write the edited data from the RK-100S Sound Editor into the RK-100S. 

. In the Library window, click the [PROGRAM] button to access the Program page. 

. From the “Communication” menu, choose “Write all data.” 

. A dialog box will ask you to confirm the Write operation, so click [OK]. 

o
 
1
2
3

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 When you execute this operation, all 200 programs of the RK-100S will be overwritten (replaced) by 
the programs from RK-100S Sound Editor. If you want to keep the programs currently in the 
RK-100S, you must back them up beforehand. 
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Windows and functions in RK-100S Sound Editor 

onality in each window of RK-100S Sound Editor. 
 
This section provides a brief explanation of the functi

 For details on each parameter, refer to the RK-100S parameter guide. The RK-100S parameter guide 
can be downloaded from our web site (www.korg.com). 

 

Library window 
In th ine Library w dow you can manage programs and edit global data. 

 

The Library window is divided into the following two pages. To move between pages, click the page 
select buttons located at the top of the screen. 
Program page 

e 
 

 the Global page you can edit global data, and transmit and receive global data to or from the RK-100S. 
 p.21 “Global data management”) 

In the Program page you can select a program to edit, transmit and receive programs to or from th
RK-100S, edit the program name or comment, and copy or rearrange programs. (→ p.16 “Program
management”) 
Global page 
In
(→
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Program edit window 
Here yo  mode. 
From thi

u can make settings that affect the entire program, such as the program name and the voice
s window you can also open edit windows for Synth or Arpeggiator settings. 

 

[SYNTH EDIT] button 
Opens the Synth Edit window for each timbre. 
[EQ EDIT] button 
Opens the Timbre EQ Edit window for each timbre. 
Arpeggiator [EDIT] button 
Opens the Arpeggiator Edit window. 
Vocoder [EDIT] button 
Opens the Vocoder Edit window. 

anging parameters 

Master Effect [EDIT] button 
Opens the Master Effect Edit window. 
Copying or exch
The drag mark  for the ribbon, arpeggiator, vocoder, and master effect can be dragged and dropped 
to copy the parameters to a different program. The drag mark  for the timbre parameters can be 
dragged and dropped to exchange timbres 1 and 2. You can copy the timbre parameters by dragging and 

e dropping whil you hold down the [Ctrl] key (Windows) or the [option] key (Mac OS X). 
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Synth Edit window 
Here you can edit each timbre’s synth parameters such as oscillator, filter, and amp. 

 

[RANDOMIZE] button 
This sets the synth parameters to random values. 

w 
 

Timbre EQ Edit windo
Here you can edit each timbre’s equalizer. 
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Arpeggiator Edit window 
Here you can select the arpeggiator’s arpeggio type, and make settings for each step. 

 

 

Master Effect Edit window 
Here you can select the effect type for the master effects, and edit the various parameters. 

 

Copying or exchanging parameters 
Master effects 1 and 2 can be dragged and dropped to exchange them. You can copy the parameter values 
by dragging and dropping while you hold down the [Ctrl] key (Windows) or the [option] key (Mac OS 
X). 
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Vocoder Edit window 
Here you can edit the vocoder parameters. 

 

 

Log window 
This window displays the times when files were saved/loaded, the history of communication with the 
RK-100S, the accessed content, and error information. 

 

 

MIDI Monitor window 
This window displays the MIDI messages transmitted by RK-100S Sound Editor and the MIDI messages 
received from the RK-100S. 
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Basic operations in the editor windows 

 the edit windows, and how to edit the parameters.  
 

Knobs 

 
Here’s how to operate the knobs and switches shown in

Move the mouse pointer to the desired knob. The operation of the knobs will depend on the System 
setting “Knob Operation” (→ p.23 “Preference settings”). 

 You can adjust the value more finely by dragging while you hold down your computer’s [Shift] key. 

When “Knob Operation” is set to Circular 
Move the mouse pointer to the knob index (the mark that indicates the value), 
and edit the value by dragging the knob in a circle as though you were turning it. 
You can also jump immediately to a desired value by clicking the corresponding 
location.  

 
When “Knob Operation” is set to Relative Circular 

Edit the value by dragging the knob in a circle as though you were turning it. You 
cannot edit the value by clicking, as you can with the “Circular” setting. 

 
 
When “Knob Operation” is set to Linear 

Drag upward to turn the knob right (clockwise). Drag downward to turn the knob 
left (counter-clockwise). 

 
 

Sliders 
Move the mouse pointer to the desired slider, and drag it up or down. You can 
also edit the value by moving the mouse pointer to the desired parameter and 

 

moving the mouse wheel. 

 You can adjust the value more finely by dragging while you hold down your 
computer’s [Shift] key. 
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Switches and buttons 
Move the mouse pointer to the desired switch or button, and click. 

 
 

Parameters 
Parameters that you set by dragging 

Move the mouse pointer to the desired parameter. Drag upward to increase the 
value, or downward to decrease the value. You can also edit the value by moving 
the mouse pointer to the desired parameter and moving the mouse wheel. 

 You can adjust the value more finely by dragging while you hold down your 
computer’s [Shift] key. 

  
 
Parameters that you set from a popup menu 

A menu will appear when you click the desired parameter. From the 
menu, choose the desired value. You can also specify a value by moving 
the mouse pointer to the desired parameter and moving the mouse wheel.
 

 

g and dropping Draggin
The drag marks  in the edit screens allow you to copy or exchange parameters by dragging and 
dr nt program. 
 

Renaming 

opping. You can exchange timbres or master effects, or copy parameters to a differe

You can rename a program (edit its name). When you’ve edited a program, it’s helpful to assign a name 
that reflects the sound of that program. When you double-click the program name, it will be highlighted, 
and can be edited. Type the desired name from your computer keyboard, and press the [Enter] key to 
complete the operation. If you decide not to rename the program, press your computer’s [Esc] key, or 
click the mouse on some other location; the program name will revert to its original state. 
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Library management 
 

Screen items and their function 

 

[PROGRAM] button 
 Program page. This displays the

[GLOBAL] button 
This displays the Global page. 
 

Loading library data 
From the menu, choose “File”-”Open” to access the “Open” dialog box. Select the desired library data 

le and click the [Open] button. A new library window will open, and the library data will be loaded. 

aving library data 

fi
 

S
From the “File” menu, choose “Save”; the currently-open library data file will be saved by overwriting it 
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onto the existing version of that f log box will appear. Specify the 
location in which you want to sav d click the [Save] button to save 

e library data. 

ile. If the file is new, the “Save As” dia
e the file, enter the desired file name, an

th
 

Copying library data 
You can copy program or global data to another library file. Drag the [PROGRAM] button or [GLOBAL] 
button and drop it on the [PROGRAM] or [GLOBAL] button of the desired copy-destination library 
window.  

 Favorite program data can be copied by dragging and dropping it on the [GLOBAL] button. 
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Program management 
 

Screen items and their function 

 

Program name 
his indicates the name of the currently selected program. 
DIT] button 

his opens the Edit screen for the currently selected program. 
NFO] button 
his displays a dialog box that lets you edit the name or comment of the currently selected program. 
LL] button 

his switches between showing all 200 programs or 40 programs at a time in the program list. If the 
LL] button is clicked to turn it off, the number of programs that can be displayed is reduced, but even 

ore program information can be shown. 
OLUMN] button 

his switches the contents shown in the program list. 
UTO DUMP] button 

his turns the Auto Dump function on/off. If the Auto Dump function is on, selecting a program in the 
program list will automatically transmit that program to the RK-100S. 

T
[E
T
[I
T
[A
T
[A
m
[C
T
[A
T
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Program list 
This shows the currently loaded tton, and [COLUMN] button to 
witch the displayed content. To select the program you want to edit, click a program in the list. Click the 

If the [ALL] button is clicked to turn it off, the 200 programs will be displayed 40 at a time divided onto 
five pages. Click these tabs to switch between pages. 
Favorite program 
This shows the programs assigned to the favorites buttons of the RK-100S. 

Receiving programs from the RK-100S 

200 programs. You can use the [ALL] bu
s
page select tabs to switch pages. 
Page select tabs 

From the "Communication" menu, choose "Receive all programs" to load all programs from the RK-100S 
into the program list. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 With this operation, favorite program information will not be received from the RK-100S.Choose 
“Receive all data.” or “Receive global data” to receive global data from the RK-100S. 

Writing programs to the RK-100S 
From the "Communication" menu, choose "Write all programs" to transmit all programs in the program 
list into the RK-100S and write them into memory. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 With this operation, favorite program information will not be transmitted to the RK-100S. Choose 
“Write all data.” or “Write global data” to transmit global data to the RK-100S. 

Selecting a program 
Click a program shown in the program list to select it. You can also select a program by using your 
computer's cursor keys. You can select multiple programs by clicking while you hold down the [Ctrl] key 
(Windows) or [command] key (Mac OS X). You can select a contiguous range of programs by clicking 
while you hold down the [Shift] key. 
 

rogram Moving a p
You can move a program to a different location. Simply drag and drop the selected program onto the 
desired location. 
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You can also move a program to a page that is not currently displayed. Drag the program to the page 
nto select tab of the desired destination page; the page will switch, and you can then drop the program o

the desired location in the newly displayed page. 
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Exchanging programs 
You can exchange the location of two programs by dragging and dropping one of the two programs while 
holding down the [Alt] key (Windows) or [command] key (Mac OS X). As when moving a program, you 
can exchange programs located in different pages by dragging one of the programs to the page select tab 
of the other page. 
 

Copying a program 
Copying a program by dragging and dropping 
To copy a program, drag the selected program and drop it onto the desired copy-destination while holding 
down the [Ctrl] key (Windows) or [option] key (Mac OS X). The program formerly at that destination 
will be overwritten. As when moving or exchanging programs, you can copy a program to a different 
page by dragging the program to a page select tab. 
Copying a program via the menu 
1. Select the copy-source program, and from the "Edit" menu choose "Copy." 
2. Select the copy-destination program, and from the "Edit" menu choose "Paste." A duplicate program 

will be overwritten onto the copy-destination. 
 

Editing program information 
When you select a program and click the [INFO] button, the program information editing dialog box will 
appear. Edit the program name or comment, and click the [OK] button. If you decide to cancel the 
changes you made, click the [Cancel] button. 

 "Creator" and "Comment" information is not written into the RK-100S. If a program containing 
"Creator" and "Comment" data is written to the RK-100S and then received back into RK-100S 
Sound Editor, the "Creator" and "Comment" data will be lost. 

 

Initializing a program 
Select the program, and from the "Edit" menu, choose "Initialize." That program will be initialized to the 
initial program. 
 

Saving a program to a file 
You can save the selected program to your computer as a program data file. Select the program that you 
want to save, right-click (in Mac OS X, [control]-click) to display the popup menu, and choose "Save" to 
access the "Save program" dialog box. Specify the desired save location, enter a file name, and click the 
[Save] button. 
 

Loading a program from a file 
Select the program into which you want to load the file, right-click (in Mac OS X, [control]-click) to 
display the popup menu, and choose "Open" to access the "Load program" dialog box. Select the program 
data file that you want to load, and click the [Open] button. 
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Restoring a program 
You can restore the selected program to the state in which it was prior to editing (i.e., the state saved in 
the file). From the "Edit" menu, choose "Revert to saved data," and the selected program will be restored 
to the state prior to editing. 
 

Storing a favorite program 
Drag the selected program and drop it into the favorite program list to store the program at the favorite 

favorite program formerly at that location will be program location where it was dropped. The 
overwritten. 

 
 

Exchanging favorite programs 
Drag the selected favorite program and 
at the favorite program location where it

drop it at the desired destination to exchange it with the program 
 was dropped. 

 The stored favorite program information will also be applied to the favorite programs in the global 
data. 
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Global data management 
 

Screen items and their function 

 

[RECEIVE] button 
This loads the RK-100S's global data into RK-100S Sound Editor. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

[WRITE] button 
This transmits the global data from RK-100S Sound Editor to the RK-100S and writes it. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 a global data file saved on your computer. 
AVE] button 

his saves global data to your computer as a global data file. 
avorite program 
his shows the programs assigned to the favorites buttons of the RK-100S. 

[LOAD] button 
This loads global data from
[S
T
F
T
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Receiving global data from the RK-100S 
When you click the [RECEIVE] button or choose the "Communication" menu item "Receive global 

received into RK-100S Sound Editor. data," the global data from the RK-100S will be 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 

Writing global data to the RK-100S 
When you click the [WRITE] button or choose the "Communication" menu item "Write global data," the 
global data in RK-100S Sound Editor will be transmitted to the RK-100S and written. 

 Do not operate the RK-100S or RK-100S Sound Editor while data is being transmitted or received. 

 

Saving global data to a file 
You can save global to your computer as a file. Click the [SAVE] button to access the "Save global data" 
dialog box. Specify the save-location, enter a file name, and click the [Save] button. 
 

Loading global data from a file 
Click the [LOAD] button to access the "Load global data" dialog box. Select a global data file and click 
the [Open]. 
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Preference settings 
 
From the Options menu, choose "Preferences..." to open the Preferences dialog box. 

 

 

 

MIDI ports 
Find devices automatically 
f this setting is on, the port to which the RK-100S I is connected will be found and specified automatically. 
 this is off, use the MIDI IN/OUT port settings to specify the ports to which the RK-100S is connected. 
IDI IN 

his specifies the MIDI IN port to which the RK-100S is connected. You should normally set this to 
RK-100S 1 KBD/RIBBON" in Windows, or "RK-100S - KBD/RIBBON" in Mac OS X. 

IDI OUT 
his specifies the MIDI OUT port to which the RK-100S is connected. You should normally set this to 
RK-100S 1 SOUND" in Windows, or "RK-100S - SOUND in Mac OS X. 

perations 

If
M
T
"
M
T
"
 

O
Knob operation 

his specifies how the knobs shown in the editing screens will operate. For details on each type of 
peration, refer to "Basic operation in the editor windows." 
or details on each type of operation, refer to "Basic operations in the editor windows." 

ackground color 

T
o
F
 

B
This specifies the background color of screens. Select the desired RK-100S software color variation from 

e three available (“Red”, “Black” and “White”). th

 The new background color will be applied after the application is restarted. 
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Other 
Receive all data at start-up 

-100S Sound Editor 
starts up. 

 
 
 
 
 
 
 
 
 
 
 

 

 
 

If this setting is on, all data will be received from the connected RK-100S when RK
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Menus 
 

RK-100S Sound Editor (Mac OS X only) 
About RK-100S Sound Editor 

isplays version information for RK-100S Sound Editor. 
references 

isplays the Preferences dialog box (→ p.23 "Preference settings"). 

xit 
xits RK-100S Sound Editor. 

ile 

D
P

D

E
E
 

F
New 

reates new library data. 
ew From Preset Data 
reates new library data using preset data for RK-100S. 
pen 
oads library data from a library data file saved on your computer. 
ave 
aves the currently edited library data to a library data file on your computer by overwriting the existing 
ersion of that file. 
ave As 
aves the currently edited library data to a library data file on your computer with the name you specify. 
mport microKORG XL Library Data 
eads the library data file (file extension “.mkxl_all”) for microKORG XL Sound Editor and creates new 
brary data. 
mport microKORG XL+ Library Data 
eads the library data file (file extension “.mkxlp_all”) for microKORG XL+ Sound Editor and creates 
ew library data. 

xit (Windows only) 
xits RK-100S Sound Editor. 

dit 

C
N
C
O
L
S
S
v
S
S
I
R
li
I
R
n
 
E
E
 

E
Cut 

uts the selected program. 
opy 
opies the selected program. 
aste 
astes the cut or copied content into the selected program. 
nitialize 
itializes the selected program. 
evert to saved data 
everts the selected program to the state in which it was saved to the file. 

C
C
C
P
P
I
In
R
R
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Communication 
Receive all data 

-100S Sound Editor. 

l data from RK-100S Sound Editor to the RK-100S and writes it. 

 the page shown in the library window, this command reads all programs or global data 

ding on the page shown in the library window, this command transmits all programs or global data 
 the RK-100S and writes the data. 

eceive current program 
he program currently selected on the RK-100S into RK-100S Sound Editor. 
 current program 
its the program currently selected in RK-100S Sound Editor to the RK-100S. This operation does 

RK-100S. 

Loads all programs and global data from the RK-100S into RK
Write all data 
Transmits all programs and globa
Receive all programs / Receive global data 
Depending on
from the RK-100S into RK-100S Sound Editor. 
Write all programs / Write global data 
Depen
from RK-100S Sound Editor to
R
Reads t
Send to
Transm
not write the data into the 
 

Settings 
Show parameter values 
Shows the values of the knobs and sliders in the edit window. 

es dialog box (→ p.23 "Preference settings"). 

Preferences 

e PreferencOpens th

 

Window 
Open MIDI monitor window 
Opens the MIDI monitor window 
Open log window 
Opens the log window. 

ram. 

dits the next program. 
indow 
he window that is currently in the foreground. 

ly) 

Previous program 
Edits the previous prog
Next program 
E
Close w
Closes t
 

Help (Windows on
About RK-100S Sound Editor (Windows only) 

s version information for RK-100S Sound Editor. Display
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Shortcut keys 
 

Menu items 
 

Menu item Windows Mac OS X 

New Ctrl + N command + N 

Open Ctrl + O command + O 

Save Ctrl + S command + S 

Save As Ctrl + Shift + S command + shift + S 

Cut Ctrl + X command + X 

Copy Ctrl + C command + C 

Paste Ctrl + V command + V 

Receive current program Ctrl + L command + L 

Send to current program Ctrl + T command + T 

Close window Ctrl + W command + W 

 

Library window 
 

Item Windows Mac OS X 

Show information editing dialog i i 

Show edit window Enter return 

Initialize selected program Delete delete 
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